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Welcome to sy.factory V3.5.00

Introduction
sy.factory is a cross platform Librarian for the Yamaha SY77/TG77 and SY99 family of synthesizers, that
allows you to organise your SY data from the comfort of your computer.

If you plan to use sy.factory with an SY99, please read the note on  SY99 Support and some current
limitations.

sy.factory has been written by me, Derek Cook, and is available exclusively as a free download
from www.xfactory-librarians.co.uk. The free version is fully functional apart from the save and export features
(including MIDI export) and Librarian support are disabled. This allows you to evaluate the features of
sy.factory to see if you like it before buying it. If you wish to use sy.factory and enable the save and export
functions you will need to register sy.factory and pay a shareware registration fee.

sy.factory was written as I have never been able to find a librarian for the SY77 that supports the synth in the
way that I want.

I am greatly interested in user feedback for shaping future versions of sy.factory. Comments and bug reports
on the current features of sy.factory and requests for future features can be sent
to sy@xfactory-librarians.co.uk.

sy.factory is programmed in Java, so it is capable of running on any platform that supports Java version 5.0
and above.

The application has been developed and tested in JRE 6 running on PCs with Windows 7 (32 bit, and 64 bit
with both 32 and 64 bit JREs) operating systems and on Mac OS X with testing currently conducted on OSX
10.8 (Mountain Lion).

The application should also work on previous versions of of Windows and OS X, but I am no longer testing on
these versions, as at some point it's always time to move on. Having said that, so long as there are no JRE
bugs affecting the application, it should work on any OS capable of supporting JRE 6.

The screen shots you see in this manual have been taken with sy.factory running upon JRE 5.0. The look and
feel of the application will vary depending upon your target JRE and computer platform, so don't worry if
sy.factory looks slightly different upon your system.

SY99 Support

I have implemented SY99 support for sy.factory to support the entire SY family, although I only have an SY77
myself.

So, I've implemented SY99 support without access to one to perform any testing. In the early days of
programming I had some help from beta testers who had SY99s, however we have all been very busy with
life(!), so SY99 MIDI support is not as fully tested as I would like. I mean no criticism of the beta testers, as the
help that they could provide has been invaluable.

However, I have taken the decision to release sy.factory now. If you do find any problems with SY99 MIDI
support, then please get in touch with details of the problems.

SY99 file support has been tested in the same automated way that I do all of my file testing, so I have a high
degree of confidence in that.

The one area of SY99 that is not implemented in this release is custom waves and samples in TNN files, as I
have found it extremely difficult to reverse engineer how this data is stored.
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In the current release of sy.factory Wave/Sample data is preserved in TNN files, so no data is lost, but it
cannot be viewed and manipulated in sy.factory. I hope to implement full support in the next release.

Whilst Wave/Samples are not fully supported, I do not recommend adding SY99 TNN files to the library as the
Waves/Samples will not be added. The library batch importer has an option that is checked by default to not
add these files.

The reason for this is until Wave/Sample support is implemented, it is not possible to link voices that use
waves/samples so when such voices are exported from the library then they have no referenced
Wave/Sample data to extract.

Depending on the demand, and prior to full Wave/Sample support, I may rewrite this SY99 TNN switch to
allow the import of voices that do not use custom Waves/Samples.

You can of course override the switch and import SY99 TNN files, and delete/re-import them later once full
support is added.

The SY99 supports multiple songs in its sequencer. Currently, I do not know how to request a specific song.
Indeed, looking at the SY99 MIDI documentation, I do not think it is possible, as there is nothing in the
message structures to select one.

As such, when working with an SY99, I would recommend that Sequences are excluded from the bulk transfer
options in sy.factory's MIDI setup, and you work with the sequencer data only via TNN files.
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What's New in sy.factory 3.5.00
Updated the application to allow the conversion of Voices and Performances in DX7 and DX7II
SYSEX files to SY77 Voice format. Single files can be opened, or you can batch convert files.

• 

Previous Versions
V3.4.00 (27/08/2012)

Updated the application to provide access to two MIDI devices. For example, I have an SY77 and a
TG77 and need access to both.

• 

Updated MIDI Router to allow the MIDI Channel to be either the channel sent by the source device, or
to be the channel specified in the MIDI Options Dialog.

• 

V3.3.00 (23/08/2012)

Updated application to work with MMJ on OS X to provide access to external MIDI devices. The move
to MMJ is required because the Mandolane MIDI SPI is no longer supported and doesn't work on OS
X Lion and above.

• 

The MIDI Router is now available on the MIDI Menu.• 

V3.2.00 (19/01/2012)

Updated Java Launcher to work on OSX Snow Leopard and OSX Lion.• 

V3.1.02. (07/11/2012)

Updated Windows Installer to detect 32 or 64 Java Runtime Environments (JREs) and to configure
the application launcher to make use of a 64 bit JRE if available.

• 

Fixed bug that was preventing the selection of Table Views if the application was not registered• 

V3.1.01 (29/10/2011)

Fixed a bug that was not allowing Files in the Library to have the Author parameter set.• 

V3.1.00 (11/08/2011)

Added a new feature to recreate files from the library (note this will only work with Libraries created in
V2.2. onwards)

• 

Added File and Author views to the Database.• 
Added an context menu option to the Database views to allow you to see what files are using an
object.

• 

File/Save As now allows you to change the file type when saving the file.• 

V3.0.00 (07/05/2011)

SY99 support added. (See notes on what is currently supported)• 
TG77 support added.• 
The "Save As" option can now allows you to select the type of file being saved.• 
Support for MIDI file types added, allowing sy.factory to read embedded SY SYSEX data.• 
Batch importer for importing SY77/SY99 and TG77 files into the Library• 
Library Statistics dialog added, allowing you to see how big the Library is!• 

V2.0.01 (16/12/2009)

Corrected problem where file data paths on non-English locales were not being found.• 
Updated license code to allow sy.factory to unpack a license.zip if it is found in the license folder,
which simplifies installation particularly for Mac OSX users, where the standard zip extractors were
causing problems with the license file. sy.factory can also now detect a license.lic file if this has been
inadvertantly extracted

• 

V2.0 (23/11/2009)

Library support has been added, which allows you to keep all of your favourite items (Voices, Multis,
etc.) in one Library database, and then sort and filter them to find the patch that you want. This
feature is only available for registered users.

• 

V1.0 (23/03/2008)

First release of sy.factory• 
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Installation and Configuration of sy.factory
sy.factory is downloaded as a self installing file, so installation is automatic, and for most users little else, if
anything, needs to be done to get up and running.

A native installer for Windows is also available.

IMPORTANT NOTE: If the application is failing to launch on a PC with a 32 bit Operating system, then please
read the Section on adjusting the JRE Memory Configuration, as the failure is more than likely to be due to an
out of memory condition.

This section is only relevant to installing additional items not included as part of the sy.factory installer and for
configuring the Java run time memory configuration.

This section covers:

Installing Plumstone on Mac OSX to enable access to external MIDI devices.• 
Adjusting the JRE Memory Configuration if you run out of memory with large libraries.• 

Installing MIDI Extensions for MacOS X
If you wish to use the MIDI support provided by an.factory on Mac OSX, then you will need to install the MMJ
MIDI extension.

The extensions provide MacOS X Java programs access to all CoreMIDI devices, using standard Java
classes.

You can download MMJ from the mmj - Midi for java on Mac OS X website.

Then simply run the downloaded file to install the software.

JRE Memory Configuration
One disadvantage of the current Java implementations, is that they do not support virtual memory, and by
default the maximum amount of memory allowed for User Data is either 32MB or 64MB depending on the
version of the JRE.

The application launchers for PC and OSX have been setup so that more memory than the default is
allocated. These settings should be fine for most users of sy.factory.

However, if you create a very large library then it's possibly that you may run out of memory.

If you see an error dialog popping up saying sy.factory has ran out of memory, you can configure the memory
allocation settings of Java used when the application is run.

If you wish to adjust these settings, the instructions below tell you how to do so by modifying an OS specific
configuration file. It's advisable that you take a copy of the file in question first before attempting to edit it so
that you can restore it if you make a mistake.

PC Memory Configuration

The application launcher used for sy.factory is set so that it can use half of your available computer memory.

If you need to change this, you can use a simple text editor like Windows Notepad to open the
syFactory.lap file, which can be found in the folder where you installed sy.factory.

IMPORTANT NOTE:On Windows 7/Vista, I find that I cannot edit and save the syFactory.lap file in the
installation location. I have to make a copy of the syFactory.lap file (e.g. on the desktop), edit, save it and
then copy the file back to the installation location.

Find the line in the file that says janel.memory.max.total.percent=50, and adjust the maximum percentage
of total system memory from 50% to the value that you wish ex.factory to have access to.

Note, the maximum amount of memory on Windows that is supported by 32 bit Java is about 1.5GB, So if you
have a system with more than 3GB installed then with the default memory allocation configuration you may
get an error message when launching the application which states:

"Error in Java Launcher. Error whilst Launching Program with JVM"

This happens because if the total memory allocation request for the JRE is over 1.5GB then it will fail. If this
happens you will need to edit the total memory to lower it down to be below this limit. For example, I have a
Windows 7 system with 4GB of memory, and the largest percentage of memory for the JRE that I can set is
38% (1.52GB), with the launch failing with 39% of memory allocated for the JRE (1.56GB).
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The 64 Bit Java runtime environment does not have this restriction.

OSX Memory Configuration

The default maximum memory size that sy.factory will use is 256MB, which is a sensible start point suitable
for most machines.

Within Finder click on Applications in Places.

Control click over sy.factory and select the Show Package Contents menu option.

Open the Contents folder and double click on the Info.plist file.

Locate the VMOptions key.

Under this key there are two options:

-Xms specifies the minimum memory size. The default is 256M (Megabytes)• 
-Xmx specifies the maximum memory size. The default is 256M (Megabytes)• 

There is no reason to adjust the -Xms option.

Adjust the -Xmx option to the amount of memory that you require (e.g. -Xmx512M for 512 Megabytes,
-Xmx2048M for 2 Gigabytes, etc.) and save the file.

Do not set the -Xmx option to more than about 70% of your available physical memory. Setting it too high can
cause unpredictable results.

Do not disturb the layout of the file or change any of the other lines or the application may fail to start.
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Registering sy.factory
You need to register sy.factory to allow MIDI data to be exported to the SY, for data to be saved to your
computer and for Library Support to be enabled.

Please refer to the x.factory Librarian Registration Page for details on how to register sy.factory.
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Running sy.factory
Starting up sy.factory is as simple as starting any application, simple double click on the icon and you're away.

If you have registered sy.factory, then the Library will be created (if it doesn't already exist) and opened.

During start-up, a "Splash Screen" is shown. This stays visible until a few seconds after the program has
loaded and is ready for use, but can be dismissed at any time by clicking on the Splash Screen.

sy.factory remembers the size and position of the main window between sessions, so the main window will be
sized and positioned as you left it the last time.

PC
Simply double click on the program icon for the program either in an Explorer shell, or from the desktop if you
let the installer placed a shortcut there.

You can also select the program from the Start Menu. By default, sy.factory can be found under the x.factory
Librarians Program Group.

IMPORTANT NOTE: If the application is failing to launch on a PC with a 32 bit version of Windows, then
please read the Section on adjusting the JRE Memory Configuration, as the failure is more than likely to be
due to an out of memory condition.

MAC OS X
Navigate to the Applications folder in Finder and double click the sy.factory application.

You can also create "Aliases" of the application and place them anywhere you wish, such as on the desktop

To make an alias you can choose any one of the following methods:

Click the sy.factory item you have just identified and hold down the mouse button. Then, while holding
down the Command and Option keys simultaneously, drag the item to where you want the alias to
appear then let go of the mouse button and finally release the two keys. This will create an alias at
your desired location. While dragging, the ‘ghosted’ item will display a shortcut arrow which will
remain on the aliased icon when it has been created.

• 

Hold down the Ctrl key, and then click the sy.factory item as identified previously. The context menu
will be displayed, and one of the choices will be Make Alias. Click that option, and then release the
key. The sy.factory alias will appear next to the original item and can be dragged to your location of
choice.

• 

Select the sy.factory item you identified previously by clicking it once then press Command-l
(lowercase L). The sy.factory alias will appear next to the original item and can be dragged to your
location of choice.

• 

Click the sy.factory item once to select it, and then from the File menu, select Make Alias. The
sy.factory alias will appear next to the original item and can be dragged to your location of choice.

• 

Note that if your alias does not have a small arrow in the lower left corner then you have not correctly created
an alias and have probably just dragged the application launcher to a new location. If so, drag it back to the
sy.factory folder and start again.

Command Line
You can also startup sy.factory from a command shell (e.g. MsDOS). Simply change directory to where
sy.factory is located and type the following:

java -jar syfactory.jar
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The sy.factory Window
The main sy.factory window looks like this

The sy.factory user interface is a Multiple Document Interface (MDI), which allows you to have more than one
file open at a time.

The interface is divided into the now familiar layout of (from top to bottom):

The Title Bar• 
The Menu Bar• 
The Tool Bar• 
The Desktop• 
The Status Bar• 
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Menu Bar
The sy.factory menu bar provides a means of selecting common operations; typically those that affect a
complete file, or those that don't fit naturally upon a context sensitive popup menu.

Keyboard Shortcuts are provided for common operations.

sy.factory also provides context sensitive popup menus, which are accessible by right clicking over data
shown in a Child Window. Naturally the contents of the popup menus varies according to the type of data over
which the menu was popped up.

Main Menu Headings

The following menu headings are available.

File Menu• 
Edit Menu• 
View Menu• 
MIDI Menu• 
Tools Menu• 
Window Menu• 
Help Menu• 
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The File Menu

The File menu provides the following options:

New ...

Shows the Create New File Dialog, which allows you to create a new file.

Open ...

Shows the Open File Dialog, which allows you to open a specified file.

Save

Saves a file using its current name.

If the file in question is a newly created file, then the Save File Dialog is brought up to allow a name to be
entered.

This option is only enabled if your copy of sy.factory is registered.

Save As ...

Saves the selected file after a name has been entered in the Save File Dialog.

This option is only enabled if your copy of sy.factory is registered.

Save All

Saves all open files that have been modified using their current names.

This option is only enabled if your copy of sy.factory is registered.

Open Workspace ...

This option allows you to select a previously saved Workspace, which is a Collection of open windows, and
the size and positions within the main sy.factory window.

When you select this option, a dialog opens which allows you to select an sy.factory workspace file (EXW).

Save Workspace ...

This option allows you to save the current size and position of the main sy.factory window, and the
arrangement of the open windows within sy.factory to a Workspace file.

This option is only enabled if your copy of sy.factory is registered.

Export to

This option brings up the following sub menu:
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These options allow you to Export the data in the currently selected file to a variety of different formats.

This option is only enabled if your copy of sy.factory is registered.

Exit

Exits the sy.factory application.

If any files have been modified and have not been saved, you will be given the option of saving them.
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The Edit Menu

The Edit menu provides the following options:

Undo

Undos the previous edit stored in the Undo Buffer.

Redo

Redos the next edit stored in the Undo Buffer.

Clear Undo Buffer

Clears the Undo Buffer.

Cut

Places a copy of the selected Object(s) onto the Clipboard and deletes the selected Object(s) from the file.

Copy

Places a copy of the selected Object(s) onto the Clipboard.

Paste

Copies the Object(s) on the Clipboard into the highlighted location within the current file.

Find ...

sy.factory supports the ability to find Objects either by name or by category.

Searches start from the currently selected Object.

Selecting the Find ... option brings up the Find dialog, that allows you to specify the string to search for, along
with options that can be used to refine the search.

Find Next

If you have defined the Find criteria within the Find dialog, then this option will repeat the search using the
same criteria.

Goto ...

Selecting this option brings up the Goto Dialog, which allows you to quickly navigate to a numbered Object.
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The View Menu

The View menu provides the following options:

Note how some of the options change depending on whether or not the Child Window is split.

When the Child Window is split the Left/Top Pane and Right/Bottom Pane menu options have the following
sub menu.

Tool Bar

When checked the sy.factory Tool Bar is visible.

Status Bar

When checked the sy.factory Status Bar is visible.

No Split

When checked the current Child Window is not split.

Horizontal Split

When checked the current Child Window is split horizontally.

Vertical Split

When checked the current Child Window is split vertically.

Tree

When checked the main/left/top pane in a Child Window displays data in a Tree View.

Table

When checked the main/right/bottom pane in a Child Window displays data in a Table View.

Refresh

Refreshes all open Child Windows.

This command is provided in case the screen is not properly updated following an edit operation. There are a
couple of odd bugs I cannot track down on screen updates. So if you come across them as well, then this
command will force a redraw of the windows.

Preferences ...

Opens the sy.factory Preferences Dialog.
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The MIDI Menu

The MIDI menu provides the following options:

Import From MIDI

Imports Voices and Performances from the SY via MIDI to the currently selected Window.

Export to MIDI

Exports Voices and Performances to the SY via MIDI from the currently selected Window.

Note: The Export To MIDI option is only enabled if you have registered sy.factory.

MIDI Router ...

Opens the MIDI Router Dialog which allows you to use another keyboard to audition SY Data.

MIDI Preferences ...

Opens the Preferences Dialog with the MIDI Preferences Tab active.
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The Tools Menu

The Tools menu provides the following options:

Master Patch List ...

Opens the Master Patch List dialog.

This option is only enabled if your copy of sy.factory is registered.

Library Information ...

Opens the Library Statistics dialog.

This option is only enabled if your copy of sy.factory is registered.

Batch Import to Library ...

Opens the Batch Import To Library dialog.

This option is only enabled if your copy of sy.factory is registered.

Batch Convert DX7 Patches ...

Opens the Batch Convert DX7 Patches Wizard.

This option is only enabled if your copy of sy.factory is registered.
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The Window Menu

The Window menu provides the following options:

In the example given above, you'll see that after the predefined menu options there are menu options that
allow you to select the windows currently open within sy.factory (77NEWAGE.T04 and FACTORY.T01 in our
example menu).

Tile Horizontal

Arranges all non-minimised Child Windows along the horizontal axis.

Tile Vertical

Arranges all non-minimised Child Windows along the vertical axis.

Maximise Windows

Maximises all Child Windows so they all occupy the size defined by the desktop.

Restore Windows

Restores all maximised/minimised Child Windows to their normal state.

Minimise Windows

Reduces all Child Windows to their iconised state.

View SY Synthesizer Data

Opens or closes the SY Synthesizer Window which provides a view on preset and user SY synth data.

View SY Library

Note: This menu option is only visible if you have registered sy.factory.

Opens or closes the SY Library Window which provides a view on the SY Library.
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The Help Menu

The Help menu provides the following options:

Help ...

Displays the sy.factory Online Help system.

Tips and Tricks ...

Displays the sy.factory Tips and Tricks Dialog.

About ...

Displays the sy.factory About Dialog, which provides some basic information about the program, such as the
version number.

Register ...

Displays the sy.factory registration Dialog.

See the Registration Section for details of how to register sy.factory.
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Tool Bar
The Tool Bar contains buttons for common operations, such as opening and saving files.

   Creates a new file
   Displays the Open File Dialog to allow you to select a file to open
Saves the currently selected file

   Displays the Save As Dialog to allow you to select a different name for the currently selected file
Saves all the open files to disk

   Cuts the selected Objects and places them on the Clipboard
   Copies the selected Objects and places them on the Clipboard
   Pastes the contents of the Clipboard to the current selection
Undos the previous edit
Redos the previous edit

   Displays the Find Dialog to allow you to define the search criteria and then search for the first occurrence
   Searches for the next occurrence of the search criteria defined in the Find Dialog
   Imports Voices/Performances from the SY via the MIDI interface
   Exports Voices/Performances to the SY via the MIDI interface
   Displays the Preferences dialog where you can configure sy.factory
   Displays the sy.factory Online Help index page
   Enables Context Sensitive Help
   Displays the Tips and Tricks Dialog
   Displays the About Dialog

The Save and MIDI export buttons are only enabled if sy.factory is Registered.

The Tool Bar can be dragged and made a floating toolbar by clicking and dragging the handle to the left of the
Tool Bar.

The Tool Bar can also be dragged to a different window border other than the top border.

The Tool Bar can be hidden/unhidden by the Tool Bar menu option on the View menu.

The Tool Bar whilst floating can be docked once more by closing it.
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Desktop
The Desktop portion of the window is where the SY data is portrayed. Several files may be opened and shown
within Child Windows upon the Desktop portion of the window. The following example shows three Child
Windows open on the Desktop.

The Window Menu provides menu options to:

Tile (either vertically or horizontally) all Child Windows that are not iconised• 
Minimise all Child Windows• 
Maximise all Child Windows• 
Restore all Child Windows• 
Select a specific Child Window• 
Open the SY Synthesizer Window• 
Open the SY Library Window• 

When a file is opened, a Child Window is added to the Desktop Area.
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Child Window
The Child Window provides the View upon the data within the file it is associated with.

The Child Window is maximised by default when it is opened, and can be minimised, restored or closed by the
buttons to the right of the Child Window's title bar.

The menu options on the View menu can be used to change the View to a Table view, which can show either
a Voice Table or a Performance table.

It's also possible to have either a horizontally or a vertically split View which can show any of the following
combinations:

A Tree and a Table• 
A Table and a Tree• 
Two Trees• 
Two Tables• 

The default Child Window View applied when a file is opened is set in the Default View Tab of the Preferences
Dialog.

The following example shows a Child Window that is split and showing both a Tree View and a Table View on
the same data.

The Tree and Table views support drag move and drag copy operations, and the views will automatically
scroll whilst drag operations are in progress.

sy.factory also provides two special Child Windows:

The SY Synthesizer Window.• 
The SY Library Window (This Window is only available if you have registered sy.factory).• 
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Tree View

The Tree View shows the SY data as a hierarchical tree, and can show more information than the Table
View. The following example shows a split Child Window with two Tree Views.

Basically, information is shown as a set of hierarchical Objects. Objects may have children attached to them,
and they themselves may have further child Objects (e.g. a Voice Object, has a child Object for its Elements,
and this Object groups all the Elements of the Voice).

The basic tree structure is a Root Object at the top of the tree under which are various Object Collections
which themselves contain further data.

Objects are displayed in one of two colours:

Black if the Object is not referenced by another Object• 
Blue if an Object is referenced by another Object (e.g. a Voice being used within a Multi)• 

The Tree View allows multiple Objects to be selected, which is useful for performing operations only upon
certain Objects. You can only perform operations upon Objects of the same type.

If you wish to perform an operation upon all Objects in a Collection, simply select the Collection containing the
Objects.
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Table View

The Table View provides a more high level overview of the data than the Tree View, and the representation of
the data is more compact. The following example shows a Child Window with a single Table View providing
information on a file's Voices.

The Table View can only show one Collection of Objects at a time.

You can select what a Table View shows by right clicking within the table to access the context sensitive
menu, upon which can be found menu options to select the different data types available in a file.

Each row within the table shows one Object.

The Table View's context sensitive popup menus support editing operations. The cells in a Row that contain
the Object's Name can be directly edited by clicking in them.
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SY Synthesizer Window

The SY Synthesizer Data Window is made visible by ensuring the View SY Synthesizer Data option in
the Window Menu is checked.

The Title of the Window indicates whether or not the connected synthesizer (as defined in the Device Type
tab of the Preferences Dialog) is an SY77, TG77 or SY99.

This Child Window is a special View that shows the following SY Preset and User Data Collections:

Preset Voices• 
Preset Waves• 
Preset Microtunings• 
Preset Pans• 
User Voices• 
User Multis• 
User Master Control Setups (SY99 only)• 
User Pan data• 
User Microtuning Data• 
User Sequencer data (SY77/SY99 only)• 
System Settings• 

The purpose of showing these User Data Collections is to allow drag and drop transfers of User data, such as
Voices and Multis between sy.factory and the SY via the MIDI Interface.

The Preset data can be drag copied onto user data if required. For example, you can drag a Preset Voice
onto a Multi part.
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SY Library Window

Note: This Window can only be opened if you have registered sy.factory.

The SY Library Data Window is made visible by ensuring that the View SY Library option in the Window
Menu is checked.

This Child Window is a special View that shows the contents of the SY Library.

Like the standard Table View, you can select the view of type of objects that you wish to view (e.g. Voices,
Performances, etc.), which includes Files and Authors that are stored in the Database.

The window can be configured to be either a Tree or a Table view. The Table view is recommended because
filtering capabilities are available, which are described below.

SY Library Table View Columns

The following columns can be found in the Library table. Not all columns are available in a table view,
depending on the type of data being viewed. For example, only Voices have the Type Column.

Category The Category of an Object. Not all Objects have a defined Category
Name The Name of an Object. Note that this name can be up to 50 characters long, so you can

provide a more meaningful name for an object within the Library (the original name is preserved
for when the object is copied from the Library).

Type The type of the object (e.g. the type of voice). Not all Objects have a defined Type.
Synthesizer The synthesizer that this object is for: either SY77, TG77 or SY99. This allows you to filter or

sort by synthesizer type.
Rating Each Object object can be assigned a rating, from unrated to five stars. Filtering on this column

will allow you to quickly find you favourite items.
Comment Each object can have a comment associated with it of up to 100 characters. For example, you

could use this field to contain keywords that you use to describe a sound's character in more
detail. This could help you to define a filter to search for a sound.

Author You can define the Author for each Object. This field defaults to "Unknown" when objects are
added to the Library. You can setup sy.factory to prompt you for an Author name when a new
file is being added to the database.

Source The name of the source file that an Object was copied from when it was added to the Library.
Table Sorting

You can sort a table by a column by clicking on a column heading in the table header. for example to sort
voices by name, then click on the Name column heading. The sorting will cycle through the following states
each time you click a column header:

Unsorted• 
Sort Ascending• 
Sort Descending• 
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Table Filtering

The database table provides a very comprehensive filtering capability, which allows you to filter on any
column or combination of columns. For example, you can filter on voices with a name that contains the phrase
"Fred", combined with a category filter for "pads", combined with a type filter for AWM voices, and finally filter
for those which have a three star rating.

You can enter a filter for each column using the filter header that is above the table column names.

Table filtering works in conjunction with table sorting

A filter with a grey background is restricted to filtering by items that you can select from the drop down list. For
example, a rating value can only be unrated or rated between 1 and 5 stars

A filter with a yellow background allows you to enter a PERL Regular Expression string that acts as a filter.
Consider the following PERL examples for filtering by name:

drum will match all names containing the phrase drum (anywhere in the name);• 
^t will match all names beginning with the letter T ('^' anchors the search to the start of the name);• 
[0-9]$ will match all names ending with a number character between 0 and 9. ('$' anchors the search
to the end of the name);

• 

^M[0-9] will match all names starting with letter M followed by a numeric character.• 

That is just an overview of how you can use regular expressions for filtering. More details for how you can
form regular expression pattons can be found on the PERL Regular Expression Page

The drop down list for a Perl Regular Expression filter provides a history of the search terms entered during
the session.

Table Filter Controls

At the bottom of the table is a toolbar with the following controls:

Enable Filter Turns the filter on or off.
Configure
Filter

Brings up the Configure Filter dialog box allowing you to control the default behaviour of how
the Rating, Comment, Author and Source File columns are filtered.

Reset Filter Resets the filter.
The Filter control also shows you how many Objects out of the total available are being shown by the filter.

Table Filter Configuration

When the Configure Filter Dialog button is selected, the following dialog appears that allows you to control
the behaviour of the filter for specific columns.

Rating - allows you to select whether or not an exact match is required, or if the filter is to allow
ratings greater than or equal to the one shown.

• 

Comment - allows you to select if a PERL Regular Expression can be entered, or if choices are
restricted to the choices provided in the drop down dialog.

• 

Author - allows you to select if a PERL Regular Expression can be entered, or if choices are restricted
to the choices provided in the drop down dialog.

• 

Source File - allows you to select if a PERL Regular Expression can be entered, or if choices are
restricted to the choices provided in the drop down dialog.

• 

The default state of the filters can be configured on the Library Preferences tab in the Preferences Dialog.
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Status Bar

The Status Bar provides the following pieces of information (from left to right) for the Child Window which is
currently selected:

The name of the file currently open, if any. If no file has been selected then this field is blank• 
The type of the file• 
Whether or not the file has been modified• 
If the left/top split pane is a table this indicator identifies what the table is showing (e.g. Voices or
Multis)

• 

If the right/bottom split pane is a table this indicator identifies what the table is showing (e.g. Voices or
Multis)

• 

The Status Bar can be hidden/unhidden by the Status Bar menu option on the View menu
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Program Features
sy.factory provides the following features:

File Operations• 
Undo/Redo Support• 
Clipboard Support• 
MIDI Support• 
Library Support• 
Find and Goto Support• 
Editing Features• 
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File Operations
sy.factory supports the following file operations:

Create New Files• 
Open Existing Files• 
Save Files• 
Open and Save Workspaces• 
Export Data• 
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Create New File

When the New File ... option from the File Menu or the  button on the Toolbar is selected, the following
dialog is shown:

This dialog allows you to select the type of file to create from the following:

SY77 TNN (SY77 All)• 
SY77 JNN (SY77 Synth All)• 
SY77 KNN (SY77 Sequencer All)• 
SY77 SYX Memory Bulk Dump (SY77 SYSEX format)• 
SY77 SYX Voice Edit Buffer (SY77 SYSEX format)• 
SY77 MIDI Memory Bulk Dump (SY77 SYSEX embedded in MIDI file format)• 
TG77 MIDI Voice Edit Buffer (TG77 SYSEX embedded in MIDI file format)• 
TG77 SYX Memory Bulk Dump (TG77 SYSEX format)• 
TG77 SYX Voice Edit Buffer (TG77 SYSEX format)• 
TG77 MIDI Memory Bulk Dump (TG77 SYSEX embedded in MIDI file format)• 
TG77 MIDI Voice Edit Buffer (TG77 SYSEX embedded in MIDI file format)• 
SY99 TNN (SY99 All)• 
SY99 JNN (SY99 Synth All)• 
SY99 KNN (SY99 Sequencer All)• 
SY99 SYX Memory Bulk Dump (SY99 SYSEX format)• 
SY99 SYX Voice Edit Buffer (SY99 SYSEX format)• 
SY99 MIDI Memory Bulk Dump (SY99 SYSEX embedded in MIDI file format)• 
SY99 MIDI Voice Edit Buffer (SY99 SYSEX embedded in MIDI file format)• 

The new data file is given a name in the form of "syFactory_n", where n is a number that increments every
time a file is created.

Note, this is different from initialising data in a file, as a totally new file is created.
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Open Existing File

When the Open ... option from the File menu or the  button on the Toolbar is selected the following dialog
will appear, allowing a file to be selected.

sy.factory can open the following file types:

TNN (SY All)• 
JNN (SY Synth All)• 
KNN (SY Sequencer All)• 
SYX format files containing SY77 bulk dump or voice edit buffer data (e.g. a file created by MIDIOX)• 
MID sequence format files containing SY77 SYSEX data• 

SY factory will automatically detect if a TNN, JNN or KNN file is an SY77 or SY99 format file.

SY factory will automatically detect if SYSEX or MIDI files contain SY77, SY99 or TG77 data, including
whether or not the file is a bulk memory dump or an edit buffer file. Note that TG77 voice only dumps will be
interpreted as SY77 dumps as the voice structure and SYSEX messages are identical.

If a file selected for opening is already open, sy.factory will ask if you want to replace the file that is in
memory.

You can also open DX7/DX7II SYSEX files (if sy.factory is registered). Please read the DX7 Notes Section for
information on the conversion process.

If DX7II performances are detected when you open a DX7 SYSEX file, a J02 file is created and a dialog will
be displayed to let you know that a J02 file has been created.
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Save Open Files

When you save a file to disk using: the Save As ... command from the File Menu, or when a file created using
the New ... command from the File Menu is saved for the first time, the following dialog appears to allow you
to select a name for the file

You can save a file to a different type by selecting Files of Type to be the new file type.
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Workspaces

sy.factory allows you to save the current size and position of the main sy.factory window, and the
arrangement of the open Child Windows within sy.factory to a file known as a Workspace.

This allows you to save a Workspace you are using for future recall at a later date.

The following for each Child Window remembered:

Window size, position and status (normal, maximised or minimised)• 
Horizontal/Vertical Splits, including split position• 
Pane type(s) (e.g. Tree, Voice Table or Performance Table)• 
Tree node expansion status• 
Table column widths• 
Scroll position of the pane(s)• 
Selection state of the tree nodes, or table rows• 
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Export Data

sy.factory allows you to export the data in the currently selected file to a variety of different formats.

HTML• 
XML• 
Cubase VST Patch List• 
SpreadSheetML• 

HTML ...

This option allows you to export a listing of the data in HTML format.

XML ...

This option allows you to export a listing of the data in XML format.

This export option is intended to provide a means of importing SY data into other programmes, e.g. a
database

Cubase VST Patch Script ...

This option allows you to export a listing of the Voice/Performance data in Cubase VST patch script format.

This allows you to create patch scripts for use within Cubase to ease the selection of patches within the
Cubase environment.

Consult your sequencer documentation for details on how to install the patch scripts within your sequencer.

 SpreadSheetML ...

This option allows you to export a listing of the data in Microsoft SpreadSheetML format.

This export option is intended to provide a means of importing SY data into either Microsoft Word or Excel,
which is a great way to start documenting your patch collections

 Program Features 33



Undo Buffer
sy.factory supports a multi-level Undo/Redo Buffer facility on all edits.

The number of edits which are stored is 100.

The Undo/Redo commands can be found both within the Edit Menu, and on the Toolbar.

Please note that the undo buffer is global across all open files, and is cleared when any file is closed. This
may be improved in later releases.

The undo buffer can be cleared by the selecting the Clear Undo Buffer option on the Edit Menu. The
intention of this feature is to help cope with low memory situations, as it will free up the memory used by
stored edits.
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Clipboard Support
The sy.factory clipboard works just like the clipboard in other applications. It allows you to place an Object or a
copy of an Object upon the clipboard and then paste that Object elsewhere within a file or another file.

You can Cut/Copy either a single Object or a Collection of Objects onto the clipboard.

You can only paste from the clipboard to the current location in a file if it makes sense to do so. For example:

You cannot paste a Voice onto a Multi• 
You cannot paste ten Voices at the end of a Voice Collection if the selection is at Voice 56 or higher• 

The sy.factory clipboard is "local" to the application, and only sy.factory Objects can be placed upon it.

sy.factory does not support the system clipboard so it is not possible to cut and paste between sy.factory and
other applications. I don't think this is a major drawback because I cannot think of any circumstances where
you would wish to do this!
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MIDI Support
To use sy.factory MIDI Export support, your copy of sy.factory needs to be registered.

Configuring MIDI Support

To configure MIDI support, go to the MIDI Preferences tab in the Preferences Dialog, and set up the following:

Input MIDI Port and Output MIDI Port should be set to the MIDI port(s) to which the SY is connected• 
SYSEX Device Number should match the SY Device Number setting • 

If the Device Number on the SY is set to  ALL then it will accept data for any SYSEX Device.

You can check that these settings work by pressing the Test SY MIDI Settings button. When you press this
button a test message is sent to the SY and the subsequent Dialog will tell you if communication was
successful or if there was a problem.

The above steps set up the basic communication mechanism for MIDI support, and you then can set up the
remaining options according to your preferences:

If you never work with Multis then you can exclude them from the bulk transfers by clearing the
Include Multis in Bulk Transfer checkbox

• 

If you wish for sy.factory to always read the SY data on startup then check the Read SY MIDI Data
on Startup checkbox

• 

If you wish for changes made to the SY Synthesizer Window to be automatically written to the SY
then check the Automatically Update SY after Synth Window Edit checkbox

• 

You can adjust how long that sy.factory will wait for a response from the SY by adjusting the Timeout
Delay value, which is given in milliseconds

• 

The Transmit Buffer Size, Transmit Delay Between Buffers and Transmit Delay Between Objects values
should not require adjustment. sy.factory sends data to the SY by dividing the data into packets the size of
which are specified by the Transmit Buffer Size value. When sy.factory sends a packet it waits for the time
period specified by Transmit Delay Between Buffers before sending the next packet, and it waits for the
time period specified by Transmit Delay Between Objects after the last packet is sent. The delay
parameters are specified in milliseconds. You may need to adjust these values (smaller buffers, longer
delays) if communications is not reliable, and you may if you wish adjust these values (larger buffers, smaller
delays) to maximise data transfer performance. If you adjust these values, please ensure that you test the
transfer to ensure it is reliable, otherwise you may risk losing data. Note: Some MIDI interfaces do not like
large packet sizes: I recently upgraded to a MOTU interface and ran into problems with MIDI export until I
altered sy.factory to send messages in small chunks defined by the above parameters!

Copying/Moving Data

In operation, using MIDI is quite straightforward.

You can get all the MIDI data into any Child Window (including the SY Synthesizer Window) by selecting the
Import from MIDI option on the MIDI Menu, or the    button on the Tool Bar.

This imports all the data that you have set in the MIDI Preferences options to be included in bulk transfers.

Similarily you can also export all data using the Export MIDI option on the MIDI Menu, or the    button on
the Tool Bar.

Note if you import or export MIDI data to/from a Child Window which is opened from a data file, then the SY
Synthesizer Window is also updated with the data being imported/exported.

You can also import/export individual Objects or a selection of Objects by selecting the Import/Export memory
options upon the Object's Context Sensitive Menu. You can also use the keyboard shortcuts for doing this.

And you can also move/copy Objects between the SY Synthesizer Window and Child Window using drag and
drop.

You can also import/export a Object to/from the SY Edit Buffer by selecting a single Object and selecting the
import/export to/from SY Edit Buffer options from the Object's Context Sensitive Menu. You can also use
the keyboard shortcuts for doing this

Exporting Objects from sy.factory to the SY Edit Buffer is really handy, for example, when trying to find a
particular Object in a file and you don't wish to load the file into the SY.

Finally you can also perform all the operations on Objects in the SY Synthesizer Window that you can upon
Objects in a normal Child Window.
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If you have the Automatically Update SY after Synth Window Edit option active, when you change data
the SY Synthesizer Window then the changes are automatically exported to the SY. If you are making a lot of
changes, you may find yourself waiting quite a lot during the time it takes to do these exports.

So you may wish to turn the  Automatically Update SY after Synth Window Edit option off during intensive
editing sessions. Once you've made all your changes you then select the Export MIDI option on the MIDI
Menu, or the      button on the Tool Bar  Export option to manually export the changes.

If you quit sy.factory with changes still present in the SY Synthesizer Window that have not been exported,
then you will be asked if you wish to export the data or not.

MIDI Keyboard Routing

sy.factory has a facility to allow MIDI data from an additional MIDI input port, defined in the MIDI
Preferences options dialog, to be routed to the port you have selected for sy.factory to output MIDI data on.
This allows, for example, you to use a master keyboard (which may be closer to your computer) to be used
when auditioning SY sounds that you've sent from sy.factory to the SY edit buffer.

You access this feature by selecting the SY77 MIDI Router ... option in the  MIDI Menu or by pressing the
F12 function key whenever you need it, which activates the following dialog.

The name of the menu option will change depending on the selected device. A MIDI router option also exists
for the secondary device if enabled.

The router uses the MIDI channel defined in the MIDI Preferences dialog This can either be the channel
transmitted by the source device, or the specified channel.

The routing is active until you close the dialog by selecting the Close Channel button or by pressing the ESC
key.
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Library Support
To use the sy.factory Library, your copy of sy.factory needs to be registered.

Configuring the Library

To configure the Library, go to the Library Preferences tab in the Preferences Dialog, and set up the
preferences for the Library.

Adding Objects to The Library

The following Objects can be added to the Library.

Synthesizer• 
Voices• 
Multis• 
Master Control Setups (SY99)• 
Pans• 
Microtunings• 
Sequences• 

You can add Objects to the Library using the following methods:

Use the Add To Library function that can be found in an Object's context menu;• 
Drag Copy an Object or Selection of Objects over the SY Library Window.• 
Using the copy and paste functions of the Clipboard.• 

Please note that you can only Drag Copy Objects to the SY Library Window; you cannot Drag Move them.

Referenced objects are also copied to the Library if they are not already present in the Library. For example, if
you copy a Performance and it references Voices then they are also copied if required.

If an object is copied to the Library and it is already present in the library (either a complete match or just a
match in name), then the actions you have configured in the Library Preferences tab in the Preferences Dialog
are taken.

You can also Batch Import files to the library

Copying Objects From The Library

You can copy Objects from the Library to a file using the following methods:

Drag Copy an Object or Selection of Objects from the the SY Library Window to a file.• 
Using the copy and paste functions of the Clipboard to copy an object from the SY Library Window
and paste it to a destination file.

• 

Referenced objects are also copied from the Library if they are not already present in the destination file and if
the destination file supports them. For example, if you copy a Performance and it references Voices then they
are also copied if required.

Deleting Objects From The Library

To delete an object from the library, right click over the Object or selection of Objects and select the Delete
option from the context menu

Exporting Voices From The Library to the SY

You can send Voices from the Library to the SY edit buffer by right clicking over a selected object and
selecting the Export to SY Edit Buffer option from the context menu.

You can also Drag Copy a Voice or Selection of Voices from the the SY Library Window to the SY Synth
Window

Extracting Files from the Library

If you set the Library Table View to show Files, you can right click over a file and select the Extract File menu
option, which will recreate the original file from all the source data held in the database. The file can then be
saved. This option is also available for Files shown in the Library Tree View

List File Usage

If you right click over an object in the Library, and select the List File Usage... menu option, a dialog will be
displayed which shows all the files in the Library that make use of that object.
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Several files may refer to a single object based on the setting on the Library import preferences if they are set
not to add identical objects. If this is set only a single copy is stored, and all files that contained the identical
object only refer to that single object within the Library

New Author

If you set the Library Table View to show Authors, you can right click in the Table and select the New Author
menu option, which displays a dialog that allows you to create a new Author. This option is also available in
the Library Tree View by right clicking over the Author branch

Library Information ...

Opens the Library Statistics dialog.
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Find and Goto Facilities
Find Dialog

sy.factory supports the ability to find Objects by name.

Searches start from the currently selected Object.

Selecting the Find ... option on the Edit Menu brings up the Find dialog, that allows you to specify the string to
search for. In addition, there are several options that can be selected to help refine the search.

Find What The text string to search for.
Match Case If this option is checked then the search is case sensitive. If this option is not checked then

the search is case insensitive.
Match Whole
Name

If this option is checked then the search string must match the entire name of an Object. E.g.
"pan" would match a Voice called "pan", but not a Voice called "pandora". If this option is not
checked then the search can match a sub string within a name. E.g. "dor" would match a
Voice named "dor" and a Voice called "pandora".

Use Wild
Cards

If checked sy.factory will treat the "Find What" text as a "regular expression" to allow you
more control over the search, such as matching text at the start of a name, or the end of a
name, words with numbers in, etc.

The regular expression language used for sy.factory wild card support is the Perl Regular Expression Syntax.
Rather than try and write up this powerful syntax myself into the sy.factory documents, I'll direct you to
the Perl Regular Expression Syntax page for a description of how to use this powerful feature.

Goto Dialog

Selecting this option on the on the Edit Menu brings up the Goto Dialog

Item Type The type of Object to go to

The types of Objects that can be selected depends upon the type of file• 
If a Table View is selected then you can only go to the type of objects shown by the
Table

• 

Item Number The number of the Object to go to.
Note that Goto is not support in the SY Library Window.
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Editing Features
sy.factory supports the following editing features:

General Editing Features• 
Synth Editing Features• 
Voice Editing Features• 
Multi Editing Features• 
Master Control Setup Editing Features• 
Pan Data Editing Features• 
Microtuning Data Editing Features• 
Sequencer Editing Features• 
System Settings Editing Features• 
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General Editing Features

sy.factory supports many editing features, some of which are classed as general features that are applicable
to all or most Objects.

The general features are described here in one place for convenience:

Copy/Move Object• 
Initialise Object• 
Rename Object• 
Insert Object• 
Delete Object• 
List Object References• 
Sort Objects• 
Add Objects to Library• 

The following table shows whether or not a general edit operation can be applied to a particular type of
Object:

Object Type Move Copy Initialise Rename Insert Delete List Sort Add To Library
Synth Object Y Y Y N N N N N Y
Voice Collection Y Y Y N N N N Y Y
Voice Y Y Y Y Y Y Y N Y
Voice Microtuning Y Y Y Y N N N N N
Voiced Element Collection Y Y Y N N N N N N
Voiced Element Y Y Y N Y Y N N N
Voice AFM Element Operator Y Y Y N Y Y N N N
Voice Effects Collection Y Y Y N N N N N N
Voice Chorus Effect Unit 1 Y Y Y N N N N N N
Voice Chorus Effect Unit 2 Y Y Y N N N N N N
Voice Reverb Effect Unit 1 Y Y Y N N N N N N
Voice Reverb Effect Unit 2 Y Y Y N N N N N N
Voice Controllers Y Y Y N N N N N N
Multi Collection Y Y Y N N N N Y Y
Multi Y Y Y Y Y Y N N Y
Multi Part Collection Y Y Y N N N N N N
Multi Part N N Y N N N N N N
Multi Effects Collection Y Y Y N N N N N N
Multi Chorus Effect Unit 1 Y Y Y N N N N N N
Multi Chorus Effect Unit 2 Y Y Y N N N N N N
Multi Reverb Effect Unit 1 Y Y Y N N N N N N
Multi Reverb Effect Unit 2 Y Y Y N N N N N N
Master Control Setup Collection Y Y Y N N N N Y Y
Master Control Setup Y Y Y Y Y Y N N Y
Master Control Setup Zone Y Y Y N Y Y N N N
Pan Data Collection Y Y Y N N N Y Y Y
Pan Data Y Y Y Y Y Y N N Y
Microtuning Data Collection Y Y Y N N N N Y Y
Microtuning Data Y Y Y Y Y Y Y N Y
Sequencer Y Y Y Y N N N N Y
Sequencer Track Collection Y Y Y N N N N N N
Sequencer Track Y Y Y N Y Y N N N
Sequencer Pattern Collection Y Y Y N N N N N N
Sequencer Pattern Y Y Y N Y Y N N N
Sequencer Pattern Chain Collection Y Y Y N N N N N N
Sequencer Pattern Chain Y Y Y N Y Y N N N
Sequencer Time Signature Collection Y Y Y N N N N N N
Sequencer Time Signature Y Y Y N Y Y N N N
System Parameters Y Y Y N N N N N N
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Copy/Move Object

sy.factory makes extensive use of drag and drop for copying and moving Objects.

You can drag copy or move Objects within a file or between files, and you can drag single items or multiple
items.

The default drag operation is to move an Object, and there are two types of move operations:

Moving an Object within its Parent Collection (e.g. moving a Voice from location 1 to location 4)• 
Moving an Object to a new Parent Collection (e.g. moving a Voice from one file to another file)• 

When you move an Object to a new Parent Collection then the original Object is removed and replaced with
an initialised Object of the same type.

To copy an Object using drag and drop, you must have the DRAG MODIFIER key held down during the
operation. The DRAG MODIFIER key is platform dependent. On the PC platform it is the CTRL key.

You can tell that a copy operation is in progress as the drag image icon has a + sign visible.

When you drag multiple items they must be of the same type. For example you can drag several Voices, but
not Voices and Performances together.

sy.factory provides the following drag/drop feedback to assist in determining the effects of a drag/drop
operation:

Cursor: Indicates if the move is either a copy or a move, or if the drop is invalid (e.g. trying to drag a
Voice onto an Element)

• 

Drag image: A simple pictorial representation of what is being dragged• 
Drop Point: sy.factory shows the drop point as either a cue line drawn between Objects if an Object is
being moved within its parent (e.g. an Operator within a Voice), or a cue rectangle drawn around the
drop location for all other moves and copy operations which are valid

• 

When a Child Window is split, Objects can be dragged and dropped between either side of the split point. This
is handy, for example, for dragging Objects between the start of a Collection and the end of a Collection.

The Tree and Table views will auto-scroll in drag and drop operations, when you move the cursor to either the
top or the bottom of the pane and hold it there.

If you drag an Object onto a Tree View and over a valid parent Object (e.g. an Operator over a Voice) and the
parent Object is collapsed within the Tree, and you hold the cursor over the Parent Object for a few seconds it
will automatically expand.

sy.factory will maintain the references to Voices in Performance Parts when moving Voices within a file.

For example if you move a Voice from Location 2 to Location 10, then any Multi Parts which are referencing
Voices at Locations 2 and above will be updated to ensure they still reference the same Voices after the move
operation as they were before the move operation.

The ability to update Object references following a move or to copy referenced Objects during a move to a
new file can be selectively turned on or off within the Preferences Dialog.

Initialise Object

Initialises the selected Object to its default state.

Multiple Objects of the same type can be selected for initialisation.

The Initialise command is found upon the Context Sensitive Menu in both the Tree View and the Table
View.

Rename Object

Renames the selected Object using the following dialog, which can also be used to change the object
category:

Only one Object can be selected for renaming.
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The  Rename command is found upon the Context Sensitive Menu in the Tree View

To rename Objects in the Table View, simply double click in the Name Cell of the required Object to edit the
name.

Insert Object

Inserts an Object into a Collection at the current location.

The Insert command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can insert more than one Object at a time by selecting multiple Objects prior to executing the Insert
command.

For example if you wish to insert three Multis at location 10, select Multis 10, 11 and 12 and then execute the
Insert command.

Note that when you insert one or more Objects, then the commensurate number of Objects at the end of the
Parent Collection are removed if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, an SY Voice Collection can only contain 64 Voices, so if two Voices are inserted into the
Collection then two Voices must be removed from the end of the Collection to maintain the correct size.

sy.factory will maintain the Multi Part references to Voices when inserting Voices.

For example if you insert a Voice into a file at Location 10, then any Multi Parts which are referencing Voices
at Locations 10 and above will be updated to ensure they still reference the same Voices after the insert
operation as they were before the insert operation.

Delete Object

Deletes an Object at the current location.

The Delete command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can delete more than one Object at a time by selecting multiple Objects prior to executing the Delete
command.

For example if you wish to delete three Multis at location 10, select Multis 10, 11 and 12 and then execute the
Delete command.

Note that when you delete one or more Objects, then a commensurate number of Objects at the end of the
Parent Collection are added if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, an SY Voice Collection must contain 64 Voices, so if two Voices are deleted from the Collection
then two Voices must be added to the end of the Collection to maintain the correct size.

sy.factory will maintain Multi Part references to Voices in a Collection when deleting Voices.

For example if you delete a Voice from a file at Location 10, then any Multi Parts which are referencing Voices
at Locations 10 and above will be updated to ensure they still reference the same Voices after the delete
operation as they were before the delete operation.

List Object References

The List References command is found upon the Context Sensitive Menu in both the Tree View and
the Table View.

The List References command is only available if:

Only one Object is selected• 
The Object selected is referenced by another Object, which is indicated by the Object being coloured
blue

• 

The references are shown as follows:
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The Object being referenced is shown at the top of the Dialog followed by the Objects referencing it.

Sort Objects

The  Sort by Name command is found upon the Context Sensitive Menu in both the Tree View and
the Table View.

In the Tree View the sort options are accessed via the Context Sensitive Menu for the Collection that you
wish to sort (e.g. the Voice Collection to sort Voices).

In the Table View the sort options are accessed via the Context Sensitive Menu for any Object. The sort can
also be initiated by clicking in the Name column header.
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Synth Editing Features

sy.factory supports the following editing operations upon the Synth Object within the Tree View of a Child
Window:

Move• 
Copy• 
Initialise• 
Import from SY Memory• 
Export to SY Memory (only available if sy.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access these features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Synth Object to activate the Synth Object's Context Sensitive Menu.

The Synth Object is only shown within a Tree View  and is the first Object in the Tree View. Its name
identifies the type of file.

For example, a Synth Object representing an SY77 Bulk Dump SYSEX file is labelled:

SY77 Internal Memory SYSEX File

Import from SY Memory

Imports data from the SY Memory locations into the currently selected Child Window.

Export to SY Memory

Exports data from the currently selected Child Window to the SY Memory locations.
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Voice Editing Features

sy.factory supports the following editing operations upon the Voice Collection shown within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Import Data From SY• 
Export Data to SY (only available if sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Voice Collection Object in a file is only shown within a Tree View and is called User Voices.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Collection to activate the Voice Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Voice Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
New• 
List References• 
Import from SY Memory• 
Export to SY Memory (only if available sy.factory is registered)• 
Export to SY Edit Buffer (only if available sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Voice
or selection of Voices to activate the Voice's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Voice :

Voice Microtuning• 
Voice Elements• 
Voice Effects• 
Voice Controllers• 

New

Allows you to create a new Voice at the selected location from one of the following SY voice types.

1 AFM Mono• 
2 AFM Mono• 
4 AFM Mono• 
1 AFM Poly• 
2 AFM Poly• 
1 AWM Poly• 
2 AWM Poly• 
4 AWM Poly• 
1 AFM and 1 AWM Poly• 
2 AFM and 2 AWM Poly• 
Drum• 

This is different to initialising a voice, which always creates a default AWM voice.

Note that the options for 4 AFM Mono, 4 AWM Poly and 2 AFM and 2 AWM Poly voices are only available if
the selected voices are in voice Bank D, as the SY only allows these voices to saved in Bank D.

Import from SY Memory

Imports Voices from the SY Memory locations into the currently selected Child Window.

You can import:
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A Single Voice• 
A Selection of Voices• 
All Voices by selecting the Voice Collection• 

Export to SY Memory

Exports Voices from the currently selected Child Window to the SY Memory locations.

You can export:

A Single Voice• 
A Selection of Voices• 
All Voices by selecting the Voice Collection• 

Export to SY Edit Buffer

Exports the Voice currently selected within the active Child Window to the SY Voice Edit Buffer.

Note if you have more than one Voice selected then this operation is not available

Voice Microtuning Unit Editing Features

sy.factory supports the following editing operations upon the Voice Microtuning Unit Object shown within
the Tree View of a Child Window:

Copy/Move• 
Set Microtuning• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over
the Voice Microtuning  Unit to activate the Voice Microtuning Unit's Context Sensitive Menu.

Set Microtuning

Preset Microtunings from the SY Synthesizer Window can be dragged onto a Voice's Microtuning Unit.
Please note, the drag operation for this is COPY only. You cannot MOVE a Microtuning onto an Microtuning
Unit.

You can also drag User Microtunings from the same file onto the Microtuning Unit.
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Voice Element Editing Features

sy.factory supports the following editing operations upon the Voice Element Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Voice Element Collection to activate the  Voice Element Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Voice Element Objects within the Tree View of
a Child Window:

Copy/Move• 
Set Wave• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Voice  Element or selection of Voices Elements to activate the  Voice Element's Context Sensitive Menu.

Set Wave

The Wave for an AWM Element can be set by drag copying a Preset Wave onto the Element.

Please note, the drag operation for this is COPY only. E.g. you cannot MOVE a Preset Wave onto an
Element.

AFM Element Operator Editing Features

sy.factory supports the following editing operations upon the Voice AFM Element Operator Objects within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Voice
AFM Element Operator or selection of Voice AFM Element Operators to activate the Voice AFM Element
Operator's Context Sensitive Menu.

Voice Effects Editing Features

sy.factory supports the following editing operations upon the Voice Effects Units Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Effects Units Collection to activate the Voice Effects Units Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the individual Voice Effects Objects (Chorus and
Reverb effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Voice
Effect or selection of Voice Effects to activate the Voice Effects's Context Sensitive Menu.

Voice Controller Editing Features

sy.factory supports the following editing operations upon the Voice Controllers object shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Controllers object to activate the Voice Controllers' Context Sensitive Menu.
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Multi Editing Features

sy.factory supports the following editing operations upon the Multi Collection shown within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Import Data from SY• 
Export Data to SY (only available if sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Multi Collection Object in a file is only shown within a Tree View and is called User Multis.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Multi Collection to activate the Multi Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Multi Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
Import from SY Memory• 
Export to SY Memory (only if available sy.factory is registered)• 
Export to SY Edit Buffer (only if available sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Multi
or selection of Multi to activate the Multi's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Multi:

Multi Parts• 
Multi Effects• 

Import from SY Memory

Imports Multis from the SY Memory locations into the currently selected Child Window.

You can export:

A Single Multi• 
A Selection of Multis• 
All Multis by selecting the Multi Collection• 

Export to SY Memory

Exports Multis from the currently selected Child Window to the SY Memory locations.

Note if you have more than one Multi selected then this operation is not available

Export to SY Edit Buffer

Exports the Multi currently selected within the active Child Window to the SY Edit Buffer.

Note if you have more than one Multi selected then this operation is not available

Multi Part Editing Features

sy.factory supports the following editing operations upon the Multi Part Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
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Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over theMulti
Part Collection to activate the Multi Part Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Multi Part Objects within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Set Voice• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Copy, Move and Set Voice (which you do via "Drag and Drop"), right click
over a Multi Part or selection of Multi Parts to activate the Multi Part's Context Sensitive Menu.

Set Voice

A User Voice from the same file can be dragged onto a Multi Part to set the Voice used by the Multi Part.

Preset Voices from the SY Synthesizer Window can be dragged onto Multi Parts as well.

Please note, the drag operation for this is COPY only. You cannot MOVE a Voice onto a Multi Part.
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Multi Effects Editing Features

sy.factory supports the following editing operations upon the Multi Effects Units Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Multi Effects Units Collection to activate the Multi Effects Units Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the individual Multi Effects Objects (Chorus and
Reverb effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Multi
Effect or selection of Multi Effects to activate the Multi Effects's Context Sensitive Menu.
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Master Control Setup Editing Features

sy.factory supports the following editing operations upon the Master Control Setup Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Import Data from SY• 
Export Data to SY (only available if sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  User Master Control Setup Collection Object in a file is only shown within a Tree View and is called
User Master Control Setups.

In the following guide, they will be called Masters for brevity.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Master Collection to activate the Master Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Master Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy and Set (which you do via "Drag and Drop"), right click over
a Master or selection of Master to activate the Master's Context Sensitive Menu. Note that the SY99 does
not allow individual masters to be transmitted and received via MIDI

Within the  Tree View of a Child Window you can also directly edit the following Objects that make up a
Master:

Master Zones• 

Import from SY Memory

Imports Masters from the SY Memory locations into the currently selected Child Window.

You can export:

A Single Masters• 
A Selection of Masters• 
All Masters by selecting the Master Collection• 

Export to SY Memory

Exports Masters from the currently selected Child Window to the SY Memory locations.

Note if you have more than one Master selected then this operation is not available

Pan Editing Features

sy.factory supports the following editing operations upon the Pan Collection shown within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Import Data From SY• 
Export Data to SY (only available if sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 
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The Pan Collection Object in a file is only shown within a Tree View and is called User Pan Data.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the Pan
Collection to activate the Pan Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Pan Data Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Import from SY Memory• 
Export to SY Memory (only if available sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Pan
or selection of Pans to activate the Pan's Context Sensitive Menu.

Import from SY Memory

Imports Pans from the SY Memory locations into the currently selected Child Window.

You can import:

A Single Pan• 
A Selection of Pans• 
All Pans by selecting the Pan Collection• 

Export to SY Memory

Exports Pans from the currently selected Child Window to the SY Memory locations.

You can export:

A Single Pan• 
A Selection of Pans• 
All Pans by selecting the Pan Collection• 
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Microtuning Editing Features

sy.factory supports the following editing operations upon the Microtuning Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Import Data From SY• 
Export Data to SY (only available if sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Microtuning Collection Object in a file is only shown within a Tree View and is called User Microtuning
Data.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Microtuning Collection to activate the Microtuning Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Microtuning Data Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Import from SY Memory• 
Export to SY Memory (only if available sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Microtuning or selection of Microtunings to activate the Microtuning's Context Sensitive Menu.

Import from SY Memory

Imports Microtunings from the SY Memory locations into the currently selected Child Window.

You can import:

A Single Microtuning• 
A Selection of Microtunings• 
All Microtunings by selecting the Microtuning Collection• 

Export to SY Memory

Exports Microtunings from the currently selected Child Window to the SY Memory locations.

You can export:

A Single Microtuning• 
A Selection of Microtunings• 
All Microtunings by selecting the Microtuning Collection• 
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Sequencer Editing Features

sy.factory supports the following editing operations upon the Sequencer Object shown within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Import Data From SY• 
Export Data to SY (only available if sy.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Sequencer to activate the Sequencer's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Sequencer Track, Pattern, Pattern Chain and
Time Signature Collections within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Collection to activate the Collection's Context Sensitive Menu.

sy.factory supports the following editing operations upon the Sequencer Track, Pattern, Pattern Chain and
Time Signature Objects within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over an
Object to activate the Object's Context Sensitive Menu.

Pattern Chain Objects also have the following extra commands on the context menu:

Start Repeat• 
End Repeat• 
End Pattern Chain• 

If you hold down the ALT key whilst selecting the End Repeat menu option, the following dialog will be
shown, which allows you to set the repeat count for the Pattern Chain Repeat

Import from SY Memory

Imports Sequencer data from the SY Memory locations into the currently selected Child Window.

Export to SY Memory

Exports Sequencer data from the currently selected Child Window to the SY Memory locations.
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System Settings Editing Features

sy.factory supports the following editing operations upon the System Settings Object shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The System Settings Object is only shown within a Tree View and is called System Settings.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
System Settings Object to activate its Context Sensitive Menu.
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Master Patch List

The Master Patch List Dialog is found on the Tools menu.

This feature is only available if your copy of sy.factory is registered.

The Master Patch List Dialog provides a means for you to generate a single patch list from a list of files.
Currently only Cubase Patch Scripts can be generated, but future versions may support other sequencers.

The Master Patch List dialog is shown below:

This dialog has the following options:

File List The list of files to incorporate into a single patch list.

If you click on one of the lines then you can edit the file either by typing or by
using the [...] button to the right of the line to bring up a file selector dialog.

Note, if you are editing a line, and you are finished, you need to select
another line, or press the RETURN key for the changes to be stored.

New Inserts a new line in the file list.
Delete Deletes the currently selected line in the file list. If no line is selected this

control is disabled.
Move Up Moves the currently selected line in the file list up one line. If no line is

selected or the selected line is the first in the list then this control is disabled.
Move Down Moves the currently selected line in the file list down one line. If no line is

selected or the selected line is the last in the list then this control is disabled.
Sort Sorts the lines into ascending alphabetical order
Cubase Exports the files identified in the file list to a Cubase format patch script file,

which is compatible with Cubase VST/SX/SL/SE.
OK Closes the dialog.
Generating The Cubase Master Patch List

When you generate a Cubase Patch Script, it is written to the directory specified by the Cubase Patch Script
Directory field in the  Misc Preferences Tab of the  Preferences Dialog. You can set this field up to export the
master patch list directly to the directory read by Cubase upon startup. This directory on my system is
C:\Documents and Settings\Derek\Application Data\Steinberg\Cubase SX
3\Scripts\Patchnames\inactive\yamaha where "C:" is the root drive that Cubase is installed on, "Derek" is
my Windows user name, and "Cubase SX 3" is my version of Cubase. You will need to vary these according
to your system drive and of course your own user name and version of Cubase.

By default the Application Data folder is hidden in Windows Explorer, so you may not see this folder first of
all. If you cannot see the folder:

In Windows Explorer select Folder Options from the Tools menu and click the View tab.1. 
Look down the Advanced Settings list and find the Hidden Files and Folders option.2. 
Select the Show Hidden Files and Folders sub option.3. 
Select OK to close the dialog.4. 

Cubase only looks for and reads patch scripts when it starts up, so if you're in Cubase after generating the
patch script then exit Cubase and start it up again.
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Configuring Cubase to Use the Master Patch List

The patch scripts generated by sy.factory should be compatible with Cubase VST/SX/SL/SE. The instructions
given below are for Cubase SX, which is the version I use. Consult your Cubase documentation for how to
install patch scripts if you have a different version.

Within Cubase:

Select MIDI Device Manager from the Devices Menu.1. 
Click on the Install Device button.2. 
Click on the SY - Master Patch List option (this is the sy.factory generated file). At the bottom of this
dialog, select your output MIDI port that the SY is connected to. You can now close this dialog. If you
cannot see the SY - Master Patch List then you have not placed it in the right folder.

3. 

This installs the patch list within Cubase and allows you to use it elsewhere within the application.

In the main Cubase screen, select or create a MIDI track that you wish to be used with the SY. In the
Inspector window (the panel to the left of the main window) click on the out control and you should now be
able to see and select the SY - Master Patch List option in amongst the MIDI ports. Also ensure the MIDI
channel number for the track matches the SY channel number.

Now when you click in the Programs control, just below the out control, you'll see a drop down list containing
all of the SY Voices names generated by sy.factory.

You can now scroll through the lists to find a Voice, an you can also type in filter text to quickly look for a
Voice.

Library Statistics

The Library Statistics menu option is found on the Tools menu.

This feature is only available if your copy of sy.factory is registered.

The Library Statistics Dialog provides a means for you to see a summary of the contents of the Library.

Batch Import To Library

The Batch Import To Library Wizard is found on the Tools menu.

This feature is only available if your copy of sy.factory is registered.

The Batch Import To Library Wizard provides a means for you to import several SY files to the library in one
go.

The Batch Import To Library Wizard has two pages to navigate through:

The Select Source Directory Page• 
The Select Destination Directory Page• 

Select Source Directory Page

The Select Source Directory Page is shown below
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This page has the following options

Source Directory You can type the name of the source directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Scan Subdirectories If this control is checked, then the Batch Converter will also include any
subdirectories that it finds within the source directory when looking for files
to convert.

If this control is not checked then any subdirectories in the source directory
will be ignored.

Ignore File Errors If this control is not checked then any errors detected during file loading will
halt the conversion process.

If this control is checked then these errors are ignored, but are logged if
logging is enabled.

Select Destination Directory Page

The Select Destination Directory Page is shown below

This page has the following options

When an Object being added
is already in the Library

Provides the action to do if an Object is added to the Library and there is
already an identical Object in the library. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 

When an Object being added
already has the same name as
an Object in the Library

Provides the action to do if an Object is added to the Library and there is
already an Object in the library with the same name. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 

Create Log File If this control is checked then a log file is created in the destination directory.

This log file is called "Log File.txt", and can be opened with any text editor
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Do Not Add SY99 TNN Files If this control is checked then SY99 TNN files are not added to the Library
by the Batch Importer.

This is temporary option and is present because until SY99 fully supports
SY99 Waves and Samples, it is recommended that data from files with
Waves and Samples is not added to the library.

Using the Batch Importer

Using the importer is quite simple.

Importing an SY file takes about 20 seconds, so if you have a lot of files to import, be prepared to leave the
importer running for a while! The import of a file will be slower if you have a large library as sy.factory needs to
check to duplicate data, so the larger the library the more data the batch importer has to search.

The importer is a simple "Wizard" and you can step through the choice pages using the Prev and Next
buttons, or exit the Wizard using the Cancel Button

Select the source and destination directory options and once that is done click on the Finish button to start
the Batch Import Wizard.

The Wizard will not allow you to select a directory that doesn't exist.

Once the Wizard starts the progress of importing files is shown in the information pane.

There is a progress bar that shows the progress for all the files that the importer has detected, and a progress
bar for the objects in the file currently being imported.

The Wizard also shows how many file errors have been encountered (assuming you have set the options to
ignore File errors).

You can cancel the import at any time by pressing the Cancel button, but you may need to wait for sy.factory
to finish the current file import before the batch conversion is cancelled.

Once completed, a summary results page is shown that summarises the import.

The Wizard can be dismissed by clicking the Close button.

You can check the results of the import by opening the Log File.txt file (assuming you left logging enabled).
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The log file is a simple text file that lists each source file and whether any errors were detected.

All errors are preceded by ** (two stars), so you can use your text editor's find/search facilities to look for ** to
quickly find any errors.

Batch Convert DX7/DX7II Files

The Batch Convert DX7/DX7II Files Wizard is found on the Tools menu.

This feature is only available if your copy of sy.factory is registered.

The Batch Convert DX7/DX7II Files Wizard provides a means for you to convert several DX7/DX7II SYSEX
files and convert them to SY77 JNN format files. Please read the DX7 Notes Section for information on the
conversion process

The Batch Convert DX7/DX7II Files Wizard has two pages to navigate through:

The Select Source Directory Page• 
The Select Destination Directory Page• 

Select Source Directory Page

The Select Source Directory Page is shown below

This page has the following options

Source Directory You can type the name of the source directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Scan Subdirectories If this control is checked, then the Batch Converter will also include any
subdirectories that it finds within the source directory when looking for files
to convert.

If this control is not checked then any subdirectories in the source directory
will be ignored.

Ignore File CRC Errors If this control is not checked then any errors detected during file loading will
halt the conversion process.

If this control is checked then these errors are ignored, but are logged if
logging is enabled.

It's recommended that this option is set, as there are many DX7 files on the
Internet with checksum errors

Select Destination Directory Page

The Select Destination Directory Page is shown below
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This page has the following options

Destination Directory You can type the name of the destination directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Create Log File If this control is checked then a log file is created in the destination directory.

This log file is called "Log File.txt", and can be opened with any text editor
Using the Batch Converter

The converter is a simple "Wizard" and you can step through the choice pages using the Prev and Next
buttons, or exit the Wizard using the Cancel Button

Select the source and destination directory options and once that is done click on the Finish button to start
the Batch Convert Wizard.

The Wizard will not allow you to select a directory that doesn't exist, and the source and destination
directories must be different to prevent you from accidentally overwriting the source DX7 files.

Once the Wizard starts, the progress of converting files is shown in the information pane.

There is a progress bar that shows the progress for all the files that the converter has detected.

The Wizard also shows how many file CRC errors have been encountered (assuming you have set the
options to ignore File errors).

You can cancel the conversion at any time by pressing the Cancel button, but you may need to wait for
sy.factory to finish the current conversion before the batch conversion is cancelled.

Once completed, a summary results page is shown that summarises the conversion.
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The Wizard can be dismissed by clicking the Close button.

You can check the results of the conversion by opening the Log File.txt file (assuming you left logging
enabled).

The log file is a simple text file that lists each source file and whether any errors were detected.

All errors are preceded by ** (two stars), so you can use your text editors find/search facilities to look for ** to
quickly find any errors.

DX7 Conversion Notes

Like any conversion where the Voice Architectures are different, perfect conversion results cannot be
guaranteed. I had a further challenge because I sold my DX7II a number of years ago as the SY77 (and my
FS1R) made it redundant! So I haven't had a reference DX7 to compare the results against. However I did
convert all of my DX7 files to FS1R format (using fs.factory) before selling the DX7II, and so the FS1R has
been used as the reference to check for gross conversion errors.

Of course, the DX7II to FS1R format was probably also not perfect! However, I tend to go by my ears and the
Voice Name to judge whether or not the conversion is giving me usable results, bearing in mind that no
conversion can be perfect. And I think I have achieved that.

Of course I haven't checked all the thousands of DX7 files that I have. I wrote a scanning program to find 10
examples of each DX7 algorithm and that gave me a list of files to focus testing on to ensure that all
algorithms were covered. Once I was happy with the converter I then did some random sampling of files to
check the results.

While the SY77 is very obviously based on the DX7 6FM Operator implementation, it is quite different in a
number of areas, the key ones being:

There are 45 algorithms on the SY77 and a mapping between DX7 and SY77 algorithms has to be
made. This is more complicated than it sounds, as instead of setting a single algorithm value (like on
the DX7) there are parameters in the operators that need to be carefully setup that define how they
work within the algorithm as the SY77 has a more complex FM implementation (e.g. multiple and
programmable feedback paths).

• 

A lot of parameters have either a more limited or greater range on the SY77, so DX7 values need to
be scaled to match the SY77 range.

• 

The big difference between the DX7 and SY77 is operator level scaling. On the DX7 you program a
single breakpoint(key value) and then a depth and curve type (exponential or linear) either side of the
breakpoint. On the SY77 you have four breakpoints and a level for each one. So this is where the
biggest difference in sound occurs as the scaling can only be approximated. This may result in voices
being brighter or duller in tone (for scaling on a modulating operator) or volume (for scaling on a
carrier operator) than the source DX7 Voice.

• 

The envelopes on the SY77 have more segments.• 

There is a preference setting in the Voice Preferences Tab in the Preferences Dialog which, if checked, will
add a little reverb, delay and chorus to the converted voices to make them a little less dry. If this option is not
checked then the SY77 Voice Effects section is disabled.

DX7II Conversion Notes

If a SYSEX file contains DX7II information (64 Voices, 32 Performances), a file containing the voices is
created with a J01 extension, and a file containing the performances (based on the referenced voices) is
created with a J02 extension. A dialog will be displayed to let you know that a J02 file has been created when
you open a single DX7II file. The Batch Converter will write a line to the log file to indicate that a J02 file has
been created for a file being imported.
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Voices in the J01 file are Single Element AFM Poly Voices. Voices in the J02 file are Dual Element AFM Poly
Voices, created to match the type of DX7II Performance (Single, Dual, Split), including settings like key range,
layer balance, layer detuning, etc.

Multis are not used on the SY because there are only 16 of them and you can only play a single channel from
the keyboard at the same time, and you can't enter a lot of the DX7II Performance info into them. So a Multi
cannot really be used for a DX7II Performance, and a Dual Element AFM Voice approach was more
appropriate. However I wanted to access both Performances and individual voices from a DX7II file, and
creating two files, one for the Voice bank and one for the Performance bank, seemed the best solution.
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Preferences
The sy.factory preferences are accessed via the View menu Preferences ... option, or the  button on
the Toolbar.

Selecting this option opens a Tabbed dialog with the following tabs which group related parameters:

Device Type Preferences• 
Voice Preferences• 
Multi Preferences• 
Check Preferences• 
Default View Preferences• 
MIDI Preferences• 
Library Preferences• 
Miscellaneous Preferences• 

To view and modify a set of parameters, click on the relevant tab.

Note: The options to copy referenced Objects with "parent" Objects (e.g. moving Voices with Multis) work by:

Checking the destination file to see if the referenced Object exists• 
If it does then the parent Object is updated after being moved to point to the existing Object in the
destination file

• 

If not then sy.factory checks to see if a blank or empty child Object is present in the destination file
(e.g. in the case of moving a Voice, a blank "INIT VOICE" is looked for)

• 

If a blank Object is found then the child Object is moved or copied and the parent Object is updated
after being moved to point to the new Object in the destination file

• 

If no blank Object is found then sy.factory gives up. Note this may result in a Partial edit (e.g. it may
have only been possible to copy a subset of Objects due to the amount of free Objects in the
destination file)

• 

The child Objects are only ever copied irrespective of whether the parent Object is being moved or
copied. This is to avoid the problem that would occur when a child Object is moved (say a Voice with
Multi), where the source child Object (which would have been initialised after the move) is also
referenced by other Parent Objects (e.g. another Multi)

• 

All the above options are sensitive to what is being dragged. For example a Multi Part, Multi Part Branch, Multi
or Multi Branch can be dragged and the necessary Objects will be copied
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Device Type Preferences
The Device Type Preferences tab is shown below:

This tab has the following options:

Device Type Allows you to select the type of Device that you have from the following
options:

SY77• 
TG77• 
SY99• 

This parameter is used by sy.factory to determine what MIDI messages to
send to the connected device. When a TG77 is selected then no sequence
data is sent or requested from the device.
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Voice Preferences
The Voice Preferences tab is shown below:

This tab has the following options:

Update Voices After
Microtuning Move

If you move a Microtuning within a file then the Voices are updated to
ensure that the correct references to User Microtunings are maintained.

Update Voices After Panning
Move

If you move a User Panning within a file then the Voice Elements are
updated to ensure that the correct references to User Voices are
maintained.

Copy User Microtunings With
Voice

If you move or copy a Voice  from a file to another file, then any User
Microtuning referenced by the Voice is also copied to the destination file if
the Microtuning is not already present in the destination file.

Copy User Pannings With
Voice

If you move or copy a Voice from a file to another file, then any User
Pannings referenced by the Voice are also copied to the destination file if
the User Pannings are not already present in the destination file.

Add Reverb and Delay to
Converted DX7 Voice

If this option is checked then a DX7 voice converted to SY77 format will
have default reverb and delay applied so that the voice is not "dry".
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Multi Preferences
The Multi Preferences tab is shown below:

This tab has the following options:

Update Multis/Parts After
Voice Move

If you move a Voice within an SYSEX file then the Multis and their Parts are
updated to ensure that the correct references to User Voices are
maintained.

Copy User Voices With Multi If you move or copy a Multi from an SYSEX file to another SYSEX file, then
any User Voices referenced by the Multi and its Parts are also copied to the
destination file if the Voices are not already present in the destination file.
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Check Preferences
The Check Preferences tab is shown below:

This tab has the following options:

Check For Duplicates When
Moving or Copying Objects

If you move or copy an Object to a destination file and the Object already
exists then a warning is presented giving you the option to continue or
cancel the operation.

Warn if Destination Object is
Referenced When Moving or
Copying Objects

If you move or copy an Object and it is overwriting an Object that is being
referenced, or you are deleting a referenced Object, then a warning is
presented giving you the option to continue or cancel the operation.
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Default View Preferences
The Default View Preferences tab is shown below:

Default View Defines the type of view that is applied to a Child Window when it is first
opened.

The following options are available:

No Split• 
Horizontal Split• 
Vertical Split• 

Pane/Left Pane/Top Pane Defines the type of view shown in the single pane of an unsplit view, the left
pane of a horizontally split view or the top pane of a vertically split view.

The following options are available:

Tree View• 
Table View• 

Right Pane/Bottom Pane This control is only visible if the Default View option is set to either
Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split view
or the bottom pane of a vertically split view.

The following options are available:

Tree View• 
Table View• 

View Tool Bar Controls if the toolbar is visible at startup.
View Status Bar Controls if the status bar is visible at startup.
View Backdrop In Child
Window

This option controls if the image backdrop is displayed in Child Windows.

You may wish to turn off this option if you find the scrolling of the Child
Window is slow on your machine.

 Preferences 72



MIDI Preferences
The MIDI Preferences tab is shown below:

This tab has the following options:

Keyboard Input MIDI Port Sets the port used for accepting MIDI data from a keyboard and
routing it to the output MIDI port using the MIDI Router Dialog.

Keyboard Input MIDI Channel Sets the channel to be used for transmitting MIDI data using the MIDI
Router Dialog. The first option Use Source Channel in the drop down
list, means that the MIDI channel from the source device is not altered.

Input MIDI Port Sets the port used for MIDI input from the available ports.
Output MIDI Port Sets the port used for MIDI output from the available ports.
SYSEX Device Number Sets the SYSEX device number used for SYSEX transfers. This must

match the Device No value set in the SY's MIDI pages. If the SY
Device No is set to all then it will receive all SY SYSEX messages
irrespective of the device number in the message.

Timeout Delay Sets the time that sy.factory waits for a response from the SY before
timing out and reporting an error. The value is specified in
milliseconds.

Transmit Buffer Size Sets the size of the transmit buffer used for sending data to the SY.
Some MIDI interfaces don't like data coming in big chunks and you
may need to set this to get a reliable transfer of data. The value is
specified in milliseconds.

Transmit Delay Between Buffers This sets the delay that sy.factory waits for between sending buffer
sized data packets. The value is specified in milliseconds.

Transmit Delay Between Objects This sets the delay that sy.factory waits for after sending a complete
object. The value is specified in milliseconds.

Test SY MIDI Settings Tests to see if MIDI communications is working using the specified
values.

Automatically Update SY after
Synth Window Edit

When this option is checked, if the SY Synthesizer Window is edited
then the edited data will be automatically sent to the SY.

Read SY MIDI Data On sy.factory
Startup

When this option is checked the Voices and Performances (if enabled)
are read from the SY during the sy.factory startup phase.

Automatically Turn off SY Bulk
Memory Protection

When this option is checked, sy.factory will turn off the SY bulk
memory protection setting before sending data via MIDI.

Include Voices In Bulk Transfer
and New MIDI/SYSEX Files

When this option is checked, the Voices are included in bulk transfers,
and a Voices collection will be included in new MIDI/SYSEX files that
you create.
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Include Multis In Bulk Transfer and
New MIDI/SYSEX Files

When this option is checked, the Multis are included in bulk transfers,
and a Multis collection will be included in new MIDI/SYSEX files that
you create. You may wish to uncheck this option if you don't use
Multis.

Include Masters In Bulk Transfer
and New MIDI/SYSEX Files

When this option is checked, the Master Control Setups are included
in bulk transfers, and a Master Control Setup collection will be included
in new MIDI/SYSEX files that you create (SY99 files only). You may
wish to uncheck this option if you don't use Master Control Setups.

Include Pan Settings In Bulk
Transfer and New MIDI/SYSEX
Files

When this option is checked, the Pan Settings are included in bulk
transfers, and a Pan Settings collection will be included in new
MIDI/SYSEX files that you create. You may wish to uncheck this
option if you don't use custom Pan Settings.

Include Microtunings In Bulk
Transfer and New MIDI/SYSEX
Files

When this option is checked, the Microtunings are included in bulk
transfers, and a Microtuning collection will be included in new
MIDI/SYSEX files that you create. You may wish to uncheck this
option if you don't use custom Microtunings.

Include Sequencer In Bulk Transfer
and New MIDI/SYSEX Files

When this option is checked, the Sequencer data is included in bulk
transfers, and a Sequencer will be included in new MIDI/SYSEX files
that you create (SY77/SY99 files only). You may wish to uncheck this
option if you don't use the Sequencer.

Include System Settings In Bulk
Transfer and New MIDI/SYSEX
Files

When this option is checked, the System Settings are included in bulk
transfers, and a System Settings Object will be included in new
MIDI/SYSEX files that you create.

The Transmit Buffer Size, Transmit Delay Between Buffers and Transmit Delay Between Objects values
should not require adjustment. sy.factory sends data to the SY by dividing the data into packets the size of
which are specified by the Transmit Buffer Size value. When sy.factory sends a packet it waits for the time
period specified by Transmit Delay Between Buffers before sending the next packet, and it waits for the
time period specified by Transmit Delay Between Objects after the last packet is sent. The delay
parameters are specified in milliseconds. You may need to adjust these values (smaller buffers, longer
delays) if communications is not reliable, and you may if you wish adjust these values (larger buffers, smaller
delays) to maximise data transfer performance. If you adjust these values, please ensure that you test the
transfer to ensure it is reliable, otherwise you may risk losing data. Note: Some MIDI interfaces do not like
large packet sizes: I recently upgraded to a MOTU interface and ran into problems with MIDI export until I
altered sy.factory to send messages in small chunks defined by the above parameters!
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Library Preferences
The Library Preferences tab is shown below:

This tab has the following options:

When an Object being added
is already in the Library

Provides the action to do if an Object is added to the Library and there is
already an identical Object in the library. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
Ask What To Do• 

When an Object being added
already has the same name as
an Object in the Library

Provides the action to do if an Object is added to the Library and there is
already an Object in the library with the same name. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
Ask What To Do• 

Copy Referenced Objects to
Library

If this Option is checked, then any Objects being referenced by an Object
being added to the Library are also added to the Library.

Prompt for Author of File
When Adding a File

If this Option is checked then sy.factory will ask for the Author of the file if
one has not already been entered.

Default Filter for Rating
Column

Sets the default filter type for the Rating column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Comment
Column

Sets the default filter type for the Comment column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Author
Column

Sets the default filter type for the Author column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Source
Column

Sets the default filter type for the Source column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 
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Miscellaneous Preferences
The Miscellaneous Preferences tab is shown below:

This tab has the following options:

Startup Directory Allows the startup directory to be specified. Note: no validation is performed
on this pathname, so please ensure it is valid. I may add validation later.

The [...] button to the right of the field brings up a dialog that allows you to
select the directory instead of typing it in.

Cubase Patch Script Directory

Specifies the directory where Cubase patch scripts are written. Note: no
validation is performed on this pathname, so please ensure it is valid. I may
add validation later.

The [...] button to the right of the field brings up a dialog that allows you to
select the directory instead of typing it in.

Load Last File On Startup Controls if the last file opened in the previous session is automatically
loaded when dx.factory is next invoked.
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Online Help
sy.factory provides a full online version of the sy.factory manual.

If you select Help ... from the Help Menu or the   button on the Tool Bar, the Help Window is opened.

The Help Window works just like a web browser window, so its operation should be quite familiar to you.

The left pane of the Help Window shows a tabbed navigation pane to allow you to quickly navigate to a topic,
whilst the right hand pane shows the help topic.

The navigation pane can show three different views, depending on which tab you select:

    Displays the Table of Contents Navigation Pane, providing a structured list of sy.factory topics• 
    Displays the Index Navigation Pane, providing an indexed list of sy.factory topics• 
    Displays the Search Navigation Pane, allowing you to search the help topics for keywords• 

The Help Window has the following Tool Bar buttons:

    Navigates backwards to the last page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

    Navigates forwards to the next page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

    Selects the home page• 
    Refreshes the current page• 
    Prints the current page• 
    Displays the print settings dialog• 
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Context Sensitive Help
You can access context sensitive help by:

pressing the your Computer Platform's Help Key ( F1 on the PC platform), which will load the help
page associated with the Component within the sy.factory Window that currently has Focus (is
responding to the keyboard and mouse).

• 

pressing the  button on the Tool Bar and the clicking over the item of interest• 

You can press the Help Key in any sy.factory Dialog to access the relevant help page for the Dialog.
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Tips and Tricks
The sy.factory tips and tricks dialog is shown below:

This dialog has the following controls:

Close Closes the Tips and Tricks Dialog
Next Tip Selects the next tip in sequence
Show Tips at
Startup

If checked then when sy.factory starts up, the Tips and Tricks Dialog is automatically
opened

List of Tips and Tricks
Just in case you want the tips and tricks shown by the dialog as one single list, here they are.

Library Support

sy.factory provides a Library facility that allows you to store all your data in one place, and use filtering and
sorting facilities to locate the data that you want.

(NOTE: Library features are available only to registered users).

MIDI Support

sy.factory supports the transfer of Voices, Multis and other data types between sy.factory and the SY via
MIDI.

(NOTE: The MIDI export features are available only to registered users).

Context Sensitive Help

If you press the Help Key ( F1 on a PC) then you can get context sensitive help, including within Dialogs.

Keyboard Shortcuts

sy.factory supports numerous keyboard shortcuts as an alternative to using the mouse.

Take a look in the online help or the sy.factory manual for details of the supported keyboard shortcuts

Object Colouring

If a Voice is coloured blue, then it is being referenced by a Multi.

If you right click over a blue Voice you'll find a "List References" context menu item, which will show you the
Multis that reference this Voice.

An Object in the sequencer data is coloured green if it has data stored it.

An Object in the sequencer data is coloured red if it has no data in it.

Table Sorting

You can sort Voice and Multi Tables by name by clicking in the Table Name Column header, and they can be
sorted by category by clicking in the Table Category column header.
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New Voice

You can create a new voice using the New popup menu item in the tree view and the table view.

You can only DRAG COPY Certain Objects

If you are trying to perform a drag operation of a Voice onto a Multi Part and are wondering why sy.factory is
not allowing you to perform the drag, you must be holding down the CTRL key during the drag. Holding down
the CTRL key turns the operation from a Drag Move operation to a Drag Copy operation.

Sometimes during a drag operation, the only sensible operation that can be undertaken is a copy operation.

Copying/Moving Objects to a Different File

When you copy an Object to a different file then any Objects it references can also be copied at the same
time.

For example of you move a Multi to a new File, then the referenced Multis are also copied:

This feature can be off if required within the Preferences Dialog.

MIDI Router

Press the F12 key and you get a "MIDI Router" popping up which, whilst active, will route MIDI data form the
Keyboard MIDI Port through to the Motif Output MIDI Port. This allows you to have the USB connection
selected on the Motif, whilst allow you to play data coming from a standard MIDI interface.

Master Patch List

The Master Patch List dialog under the Tools menu allows you to define a list of files that are exported, along
with preset voice definitions, as a master patch list for use in supported sequencers to select patches.
Currently only Cubase VST/SX/SE/SL patch lists are supported.

Setting a Pattern Chain Repeat

When you select the End Pattern Chain Menu option and hold down the ALT key at the same time, a dialog
appears that allows you to select the number of repeats.

Workspaces

sy.factory allows you to save a Window arrangement as a Workspace which you can then recall at a later
date.

Moving Voices within a File

When you move a Voice within a file then any Multis that reference the Voice being moved can be updated to
ensure they all still reference the correct Voices after the move.

I think you'll agree this is a cool feature!

This feature can be off if required within the Preferences Dialog.

The SY Synthesizer Window

sy.factory has a special window called the SY Synthesizer Window. This is a special window that represents
the SY synthesizer itself.

By setting up the MIDI preferences settings you can:

Automatically import data from the SY synth into this SY Synthesizer Window when sy.factory starts
up

• 

Automatically export data from the SY Synthesizer Window to the SY Synth when the data in the SY
Synthesizer Window is edited

• 

Copying Voice and Multi Effects Units

Within sy.factory you can copy Voice Effects Units (Reverb and Chorus) to Multi Effects units and vice versa.

Exporting Cubase/Protools Patch Lists

You can export Patch lists from SYSEX files for use within either Cubase VST, Protools or Sonar.

You can also export file information to HTML, XML or SpreadSheetML formats.
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The relevant options can be found on the File Menu under the Export option

The Number After An Operator

In the Tree View you may notice that an operator has a number included after it in brackets. This number is
the "checksum" value associated with the operator, and is included as a signature and as a simple way of
distinguishing between operators.

Exporting Files to MIDI

You can export a file directly to MIDI once it is opened. If you do this, then the data being exported is also
copied to the SY Synthesizer Window.

Importing Files from MIDI

You can import directly from MIDI into a file. If you do this, then the data being imported is also copied to the
SY Synthesizer Window.
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About sy.factory
The about dialog is shown when the About ... option from the Help Menu or the  button on the Tool Bar is
selected.

The dialog shows some basic information about the program including the version number and the registration
status of sy.factory.

It's also a chance to take a close look at the excellent Splash Graphic provided by Torus!
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Glossary
Term Definition
Child Window A window associated with an SY data file that you have opened that is used to display the

contents of the file.

Several Child Windows can be open within the sy.factory Desktop.
Clipboard A temporary storage area used for transferring data within a Child Window or between

Child Windows.
Collection A group of similar and related Objects.

For example a Voice Collection stores the 64 Voice Objects that a file can contain
Context
Sensitive Help

The ability of the help system to tailor the help being displayed according to where the user
pressed the Help key.

Context
Sensitive Menu

The popup menu that is displayed in either the Tree View or Table View that provides a set
of commands specific to the currently selected Object

Desktop The area within the sy.factory window where Child Windows can be opened
Drag and Drop The name for the mechanism that allows a use to move data by dragging it with a mouse

and dropping it at a new location.
DRAG
MODIFIER

The keyboard key that is held down to turn a Drag and Drop move operation into a copy
operation.

On the PC platform, the DRAG MODIFIER key is the CTRL (control) key
JRE Java Run-time Environment. This provides the Java environment which sy.factory needs in

order to run.

Sun Microsystems provides the JRE for PC systems, and Apple provide their own JRE for
MacOS X

Library A repository where you can store all of your data.
MDI Multiple Document Interface. The type of user interface used by sy.factory which allows

several Windows to be open within the main application window.
Menu Bar The area of the sy.factory Window that contains the set of menus used for accessing the

main functions provided by the application.
MIDI Musical Instrument Digital Interface. The primary means by which digital data is exchanged

in a serial form between synthesizers and computers.
MMJ A MacOS X specific library that provides the means by which external MIDI devices can be

accessed with the Java MIDI framework.
Object A piece of SY data such as a Voice or Multi.
Reference The means by which the SY associates an Object (such as a Voice) with another Object

(such as a Multi Part). The reference provides the link between the two, and in the case of
the SY, the link is simply the number of the referenced Object.

Regular
Expression

A system by which certain character sequences are interpreted not as plain text but as
commands that can provide a tailored search for occurrences of text

Status Bar The area of the sy.factory Window that is used to display status information upon the
currently selected Child Window. 

SY Library
Window

A special instance of a Child Window that doesn't display data in a file, but which displays
the data stored in the SY Library.

SY Synthesizer
Window

A special instance of a Child Window that doesn't display data in a file, but which displays
User data imported from the SY via MIDI

Table View A View which displays data in a file arranged in tabulated rows of data
Tool Bar The area of the sy.factory Window that contains a set of buttons to provide easy access to

commonly used commands
Tree View A View which displays data in a file arranged in a hierarchical tree structure.
View The means by which the data in a file is viewed.

A Child Window provides the view upon an SY File that you have opened.

The view can be either a Tree View or a Table View.

You can have several views open upon the same data, for example when you have split a
Child Window.

Workspace An arrangement of the main sy.factory Window and Child Windows which can be saved for
subsequent recall.
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Keyboard Short Cuts
sy.factory provides many keyboard shortcuts for navigation and performing editing operations.

In general, navigating between components uses these keys:

Tab. Moves keyboard focus to the next component or to the first member of the next group of
components.

• 

Ctrl-Tab. Moves keyboard focus to the next component or to the first member of a group of
components when the current component accepts a tab (as in text fields, tables, and tabbed panes).

• 

Shift-Tab. Moves keyboard focus to the previous component or to the first component in the previous
group of components.

• 

Arrow keys. Move keyboard focus within the individual components of a group of components--for
example, within menu items in a menu or within tabs in a tabbed pane.

• 

The shortcuts are divided into the following categories:

Keyboard shortcuts for the Desktop and Child Windows• 
Keyboard shortcuts for Tree Views• 
Keyboard shortcuts for Table Views• 
Keyboard shortcuts for Editing within Tree and Table Views• 
Keyboard shortcuts for the Preferences Dialog• 
Keyboard shortcuts for Text Editing Fields• 

Keyboard Shortcuts for the Desktop and Child Windows

Action Keystroke Notes

New File Ctrl-N

Open File Ctrl-O

Save File Ctrl-S

Save File As Ctrl-A

Save All Files Ctrl-L

Open Workspace Ctrl-ALT-O

Save Workspace Ctrl-ALT-S

Tile Horizontally Ctrl-H

Tile Vertically Ctrl-V

Maximise Windows Ctrl-M

Restore Windows Ctrl-R

Minimise Windows Ctrl-I

Closes Child Window Ctrl-F4

Moves Child Window Ctrl-F7

Resizes Child Window Ctrl-F8

Minimizes Child Window Ctrl-F9

Switch to next Child Window on the
Desktop

Ctrl-F6
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Keyboard Shortcuts for Tree Views

Action Keystroke Notes

Expands current Object Right arrow

Collapses current Object, or moves
focus to Parent Object

Left arrow

Moves focus up one Object Up arrow

Moves focus down one Object Down arrow

Moves focus to first Object in Tree
View

Home

Moves focus to last Object in Tree
View

End

Moves up one view Page Up

Moves down one view Page Down

Selects all Object in Tree View Ctrl-A, Ctrl-/

Deselects all Object in Tree View Ctrl-\

Extends selection down Shift-down
arrow

Extends selection up Shift-up arrow

Extends selection to beginning of
Tree View

Shift-Home

Extends selection to end of  Tree
View

Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Shortcuts for Table Views

Action Keystroke Notes

Moves up one row Up arrow
Shift-Return

Moves down one row Down arrow
Return 

Scrolls up one view Page Up

Scrolls down one view Page Down

Moves focus and view to first cell in
the current row

Home

Moves focus and view to last cell in
the current row

End

Moves focus and view to first cell in
the current column

Ctrl-Home

Moves focus and view to last cell in
the current column

Ctrl-End

Allows editing in a Category cell F2, Down Arrow

Allows editing in a Name cell. F2

Resets cell to the state it was in
before it was edited

Escape

Selects entire table Ctrl-A

Extends selection up one row Shift-up arrow

Extends selection down one row Shift-down
arrow

Extends selection to beginning of
table

Ctrl-Shift-Home

Extends selection to end of table Ctrl-Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Editing Short Cuts for both Tree and Table Views

Action Keystroke Notes

Undo Ctrl-Z

Redo Ctrl-Y

Cut Ctrl-X

Copy Ctrl-C

Paste Ctrl-V

Find Ctrl-F

Find Next F3

Goto Ctrl-G

Insert Object INS Not allowed on
Collections

Delete Object DEL Not allowed on
Collections

Rename Object F4 Single Named
Object Only

Initialise Object F5

List References F6 Single Named
Object Only

Export to MIDI Edit Buffer F8 Single Voice or
Performance Only

Export to MIDI Memory Shift-F8 Voices or
Performances Only

Import from MIDI Edit Buffer F9 Single Voice or
Performance Only

Import from MIDI Memory Shift-F9 Voices or
Performances Only
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Keyboard Shortcuts for the Preferences Dialog

Action Keystroke Notes

Navigates through tabs Arrow keys

Moves from tab to its associated
content pane

Ctrl-down
arrow

Moves from content pane to its
associated tab

Ctrl-up arrow

Keyboard Shortcuts for Text Editing Fields

Action Keystroke Notes

Moves insertion point one character
to the right

Right arrow

Moves insertion point one character
to the left

Left arrow

Moves insertion point to beginning of
next word

Ctrl-right arrow

Moves insertion point to beginning of
previous word

Ctrl-left arrow

Moves insertion point to beginning of
field

Home

Moves insertion point to end of field End

Submits text entry Enter, Return

Extends selection to beginning of
line

Shift-Home

Extends selection to end of line Shift-End

Extends selection one character to
the left

Shift-left arrow

Extends selection one character to
the right

Shift-right
arrow

Extends selection to next word Shift-Ctrl-right
arrow

Extends selection to previous word Shift-Ctrl-left
arrow
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Credits
Thanks go to Jim Atfield for general debugging duties, including OSX compatibility, and for also checking out
the behaviour of the installer on MAC OSX, and then for loaning me his iMac so that I could sort out some
more pervasive issues. Of course, I fell in love with the iMac, so ended up getting my own!

Thanks to Clyde Atkinson for digging into his archives and providing hand worked examples of some of the
DX7 voices that he manually converted to SY77 format.

Thanks also go to Dennis (AKA "SynthJoe"), Dimitar Barbutov, and Malte Krug for their help in providing SY99
and TG77 data files for me to work up upon for for performing initial beta testing on Release 3.0.

The following "open source" projects are used either within or to build and install sy.factory:

The Table filtering capabilities in the Library Window is based on TableFilter by Luis M. Pena• 
The sy.factory PDF documentation file is created from the JavaHelp HTML files
using <HTML>DOC This is a great tool that allows me to maintain just one set of documentation files
and create both online help and PDF manual formats of the documentation.

• 

The sy.factory JAVA installer is provided by IZPACK• 
The PC EXE installer is provided by JSmooth• 
The PC Native Launcher is provided by Janel• 
Mac OSX integration is provided by Eirik Bjørsnøs's "Macify" library• 
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sy.factory License
The unregistered version of sy.factory allows you to evaluate the features of the program, which are fully
functional except the File Save, MIDI Export and Librarian features.

However, sy.factory cannot be included as part of a commercial distribution or on other web sites without the
express permission of the Author. I am happy for you to provide links to www.xfactory-librarians.co.uk, to
maximise public access to sy.factory.

sy.factory license files are issued to users who have registered sy.factory, to gain access to the File Save,
MIDI Export and Librarian features. If you have been issued with a license key you are not allowed to
distribute a license key to other users. Please respect this, and the amount effort I have put into making this
application.

You are permitted to install sy.factory on one computer, for which the license is valid.

If you wish to install sy.factory on more than one computer, then an additional license can be purchased at
50% of the cost of the main license.

The Author retains the copyright on the program and all of its originally developed features.

Disclaimer
Like all software products, this software is provided "AS IS", and without any warranties expressed or implied.
But hey, remember, you're getting it for a very low cost!

I have worked hard to ensure this software works correctly, as I certainly don't want it trashing my data.
However, I cannot be held liable for any problems arising as a consequence of you using this software on
your computer and your data. You use this product at your risk.

Like all new products, please proceed and evaluate with care, and ensure that all your important data files are
backed up before installation and evaluation.

Having gotten that out of the way, if you do encounter any problems, please submit a bug report
to sy@xfactory-librarians.co.uk, and I will endeavour to provide a fix for any reported problems.

Table Filter License
sy.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License, which requires
the following statement to be included in the release.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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